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Google Looker Studio ဆ ိုတာအရငတ်ိုန််းက Google Data Studio ပါ။ သမူရ  ခင ်

တိုန််းက data တတွေပ ိုတဖာ်ပပဖ ို ို့ဆ ိုရင ်Excel မ ာပပရငပ်ပ၊ Powerpoint မ ာပပရငပ်ပ မဟိုတ ်

ရငက် ိုယတ် ိုင ်code တတွေတရ်းပပ ်း chart တတွေ၊ graph တတွေပဖစ်တအာငပ်ပရပါတယ။် Data 

Studio ရ  လာတ ို့အခါ Excel လ ို spreadsheet မ   ်းကတန data လ မ််းယပူပ ်း chart မ   ်းစ ို၊ 

graph မ   ်းစ ို code တစ်လ ို်းမ တရ်းစရာမလ ိုဘ  ပပလ ို ို့ရလာပါတယ။် MySQL ၊ BigQuery 

တ ို ို့လ ို database တတွေန ို့ပါခ  တဆ်ကပ်ပ ်း data တတွေပပလ ို ို့ရပါတသ်းတယ။် Looker Studio 

ရ ို့ အဓ ကစွေ တဆာငမ်ှုကတတာို့ အငတ်ာနကန် ို့ကွေနပ်ပြူတာရ  ရင ် အခမ ို့သ ို်းလ ို ို့ရတာပ ပဖစ်ပါ 

တယ။် 

အတပခခ  Google Looker Studio အတ ကာင််းမ ို ို့လ ို ို့ Google Sheet န ို့ခ  တဆ်ကပ်ပ ်း data 

တတွေပ ိုတဖာ်ပပသတာက ို ဦ်းစာ်းတပ်းတဖာ်ပပသွော်းပါမယ။် သငခ်န််းစာပပ ်းတ ို့အခါ ပ ိုမ ာပပ 

ထာ်းသလ ို Dashboard တလ်းတစ်ခိုတညတ်ဆာကန် ိုငမ် ာပဖစ်ပါတယ။် 
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Looker Studio Homepage 
https://lookerstudio.google.com 

အထကပ်ါလပ်ိစာအတိိုင််းသ ာ်းလိိုကရ်င ်Looker Studio စာမျကန် ာကိိုရရာကပ်ါမယ။် 

Google Looker Studio မိို ို့လိို ို့ Google Account န ို့ Log in ဝငထ်ာ်းဖိို ို့လိိုပါတယ။် 

  

ရအာကက်ပ ိုက Login မဝငထ်ာ်းရင ်ရတ ွေ့ရတ ို့စာမျကန် ာပါ 

 

Report စတငပ်ပြုလပ်ုပြင််း 

 

ဘယဘ်ကခ်ြမ််းက Create 

ြလိုတက်ိိုန ပ်ိပပ ်း Report ကိိုရရ ်းပါ။ 

 

 

 

 

Report အသစ်လိုပ်လိိုကတ်ာန ို့ data ဘယက်ယမူလ  ရရ ်းြိိုင််းပါလမ်ိို့မယ။် 

ရလာရလာဆယ ်ြဏပိတပ်ပ ်းထ ကလ်ိိုကပ်ါ။ 

 

  

https://lookerstudio.google.com/
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Looker Studio User Interface 
အြိုခမငရ်နရတာကိို Edit Mode 

လိို ို့ရြေါ်ပါတယ။် 

ခပငတ် ို့သခူမငရ်တ ို့ပ ိုစ ပါ။ 

ကကည်ို့မယ်ို့သခူမငရ်တ ို့ပ ိုစ ကိို 

လိိုြျငရ်င ်View 

ြလိုတက်ိိုန ပ်ိကကည်ို့နိိုငပ်ါတယ။် 

 

View Mode ကိိုရရာကသ် ာ်းရင ်

ရအာကက်ပ ိုလိိုခမငရ်ပါမယ။် 

 

 

 

 

 

Edit Mode ကိိုခပနသ် ာ်းြျငရ်င ်Edit 

ြလိုတက်ိိုန ပ်ိပါ။ 

 

 

 

 

 

 

 

Data ြ ျိတဆ်ကပ်ြင််း 

ဒ ရလာကအ်ကကမ််းဖျဉ်းသပိပ ဆိိုရင ်

Data ြျိတတ် ို့အပိိုင််း ဆကလ်ိုပ်ကက 

ပါမယ။် Menu က Add data 

ကိိုန ပ်ိပါ။ 

 

 

စာရရ်းရနတ ို့အြျိန ်Looker Studio မ ာ Data အမျိ ်းန စ်ဆယရ်ကျာ်န ို့ြျိတလ်ိို ို့ရပါပပ ။ 

အ ဒ အထ က Google Sheets ကိိုန ပ်ိပါ။ 
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တစ်ြါမ မြျိတဖူ််းရင ် Authorize န ပ်ိရပ်းပါ။ 

ြျိတဖူ််းတ ို့သမူ ာ Authorize လိုပ်ရပ်းဖိို ို့မလိိုပါ 

ဘ်ူး။ 

 

 

 

တစ်ဆကတ်ည််း Google account 

ရတာင််းပါလမ်ိို့မယ။် Looker Studio မ ာ 

Google Login ဝငထ်ာ်းပပ ်းပပ ဆိိုရပမယ်ို့ 

Google Sheet န ို့ြျိတတ် ို့အြါ ကိိုယ်ို့ 

Google Drive ထ က sheet fileရတ ကိို 

သ ို်းလိို ို့ရရအာင ် Google accountထပ် 

ရတာင််းတာပါ။ 

URL ထ မ ာ sheet ID န ပါတရိ်ိုကထ်ည်ို့ပါ။ သငြ်န််းစာဖိိုငထ် က sheetID.txt ထ ဝငပ်ပ ်း ID 

copy ယလူိို ို့ရပါတယ။် သငြ်န််းစာဖိိုငမ်ရ ိရသ်းရင ် Download လိုပ်ဖိို ို့န  ပ်ိပါ။ ဒါမ မဟိုတ ်

ရအာကပ်ါ QR ကိို scan ပပ ်း download လိုပ်နိိုငပ်ါတယ။် 

 

1dCUr_4L1OqOC9fUSjt6SncBWdSmtWfepyAqhSY6CH4w 

Download လိုပ်ထာ်းတ ို့ Zip file 

ကိို right click > Extract လိုပ် 

ပါ။ Extractမလိုပ်ဘ တန််းဖ င်ို့လိို ို့ 

ရရပမယ်ို့ရနာကပိ်ိုင််းမ ာအ ဒ ထ  

က file ကိိုယသူ ို်းဖိို ို့ရ ိလိို ို့ extract 

န ို့တစ်ြါတည််းခဖညထ်ာ်းဖိို ို့လိိုပါ 

တယ။်  

 

ညာဘကမ် ာအမ နခ်ြစ်န စ်ြို 

ရတ ွေ့ပါလမ်ိို့မယ။် အ ဒ အ 

မ နခ်ြစ်အတိိုင််း ထာ်းပပ ်း 

Add ြလိုတက်ိိုန ပ်ိပါ 

 

 

 

အသင်ို့ရဆာကထ်ာ်းတ ို့ table ကိို click ပပ ်း Delete န ပ်ိဖျကလ်ိိုကပ်ါ 

 

https://drive.google.com/file/d/1RekPXD7OCgBHgEb8pkj-glCiswyCgaGh/view?usp=sharing
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ြ ျိတထ် ်းသည့်် data အမ ျိြု်းအစ ်းမှန်အအ ငပ်ပြုလပ်ုပြင််း 

ကျွနရ်တာ်တိို ို့ြျိတလ်ိိုကတ် ို့ Google Sheet ထ က data ရတ မ ာ Countryအမျိ ်းအစာ်းရတ ၊ 

percent အမျိ ်းအစာ်းရတ ပါပါတယ။် Data ြျိတတ် ို့အြါ သင်ို့ရတာ်တ ို့အမျိ ်းအစာ်းကိိုအ 

လိိုအရလျာကြ်န် ို့မ န််းပပ ်း Looker Studio ထ ကိိုထည်ို့သ င််းလိိုကတ်ာမိို ို့လိို ို့ လကူိိုယတ်ိိုင ်

data ထည်ို့သလိို ရာနှုန််းခပည်ို့မမ နတ်တပ်ါဘ်ူး။ 

 

Resources > Manage added data 

sources ကိိုသ ာ်းပါ။ 

 

 

 

 

 

Action ရအာကက် Edit ကိိုန ပ်ိပါ။ 

 

Country မ ာ Text ခဖစ်ရနပါတယ။် ကျွနရ်တာ်တိို ို့ data ဟာ နိိုငင် နာမညမ်ဟိုတဘ် ရခမပ ို 

မ ာရနရာြျဖိို ို့ Geo Country အမျိ ်းအစာ်းခဖစ်တာရကကာင်ို့ Geo > Country ကိိုရခပာင််းရပ်း 

ပါ 

 

Continue ဆကန် ပ်ိရပ်းပါ   

 

Country Code မ ာလည််း Text ကိိုန ပ်ိ၊ Geo ထ က Country ရခပာင််းရပ်းပါ။ 

 

Female% က Number ရိို ်းရိို်းမဟိုတ၊် ရာြိိုငန် ှုန််းခပကနိ််းမိို ို့လိို ို့ Number > Numeric > 

Percent ရရ ်းရပ်းပါ 
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Internet % န ို့ Mobile Subscription 

% တိို ို့ကိိုလည််း Numeric ထ က 

Percent ကနိ််းရခပာင််းရပ်းပါ။ 

 

 

 

ရာြိိုငန် ှုန််းခပဂဏန််းရတ ကိို 

Aggregate တနဖိ်ို်းခပရတ ို့ chart ရတ မ ာ Average aggregate ကိိုပ ခပရလို့ရ ိပါတယ။် SUM 

ကိိုခပရမ ာမဟိုတပ်ါဘ်ူး ဒါရကကာင်ို့ % တနဖိ်ို်းရတ ရ ို့ Default aggregate ကိို Average 

ရခပာင််းရပ်းပါ 

 

ပပ ်းရင ်Done န ပ်ိပါ။ Close န ပ်ိပိတပ်ါ။ 

     

Chart ထည့််သငွ််းပြင််း 

ြိုန စ်အလိိုကက်မ္ာို့လဦူ်း 

ရရခပ chart တစ်ြိုထည်ို့ 

ကကည်ို့ပါမယ။် အရငဆ် ို်း 

Filename ကိို Population 

Dashboard လိို ို့ရခပာင််းပါ။  
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Menu > Add a chart > Column Chart 

ကိိုရရ ်းပါ 

 

 

 

 

 

 

 

 

ပ ိုမ ာခပထာ်းတ ို့အတိိုင််း 

chart ကိိုရနရာြျပါ 

ြိုန စ်အလိိုကက်မ္ာို့လဦူ်းရရကိိုခပြျငတ်ာမိို ို့လိို ို့ X ဝငရိ်ို်းမ ာ ြိုန စ်၊ Y ဝငရိ်ို်းမ ာ 

လဦူ်းရရခဖစ်ရပါမယ။် Looker Studio မ ာ 

• X ဝငရိ်ို်းကိို Dimension 

• Y ဝငရိ်ို်းကိို Metric 

လိို ို့ရြေါ်ပါတယ။် 

ညာဘကအ်စ န ် Data panel ထ က 

Year ကိို ဘယဘ်က ် Dimension 

ထ က Country ရပေါ်တည်ို့တည်ို့ 

mouse န ို့ click ထာ်းပပ ်းဆ  ြျပါ။ 
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အလာ်းတပူ  ညာဘကက် Population ကိို 

ဘယဘ်က ် Metric ရအာက ် record count 

ရပေါ်ဆ  ြျပါ 

 

 

 

 

 

 

 

 

 

 

Chart မ ာ ြိုန စ်ရတ ကိို 

ငယစ်ဉကက ်းလိိုက ်(Ascending) 

စ ရပ်းဖိို ို့လိိုပါတယ။် 

Chart ရပေါ်က Sort ကိိုန ပ်ိပါ 

 

 

 

 

Year ကိို Ascending န ို့စ ပါ။ 

န စ်ြါရလာကန် ပ်ိမ  

Ascending ရရာကပ်ါတယ။် 

ဒါဆိိုရငြ်ိုန စ်အလိိုကက်မ္ာို့ 

လဦူ်းရရခပ chart တစ်ြိုရပါ 

ပပ ။  

 

 

ကမ္ာို့လဦူ်းရရအခပင ်တစ်နိိုငင် ြျင််းစ ရ ို့ လဦူ်းရရကိိုပါခပြျငတ်ယဆ်ိိုပါစိို ို့။ Dropdown list 

တစ်ြိုထည်ို့ပပ ်း filter လိုပ်ကကည်ို့ပါမယ။် 

Menu > Insert > Drop-down 

list ကိိုရရ ်းပါ 
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Chart ရ ို့ညာဘကအ်ရပေါ်ရထာင်ို့ 

မ ာ ရနရာြျပါ။ 

 

 

 

 

 

 

Looker Studio က Year လိို ို့ြန် ို့ 

မ န််းပပ ်း filter လိုပ်ထာ်းတာကိို 

နိိုငင် ခပနရ်ခပာင််းြျငပ်ါတယ။် 

ညာဘကအ်စ န ်Data panel ထ က 

Country ကိို ဘယဘ်ကက် 

Control field ရအာကက် Year 

ရပေါ်တည်ို့တည်ို့ရရာကရ်အာင ်

ဆ  ြျပါ။ 

 

 

 

 

Dropdownအလိုပ်လိုပ်လာ်းသရိရအာင ်

View ြလိုတန် ပ်ိပပ ်းစမ််းကကည်ို့ပါ။ 

 

 

 

Country dropdown ကိိုန ပ်ိပါ 

 

 

 

 

 

 

 

Country ရဘ်းကအမ နခ်ြစက်ိို click ပပ ်း select all 

ကိိုခပနခ်ဖ တပ်ါ 
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နိိုငင် တစ်ြိုြိုရရ ်းပပ ်း အမ နခ်ြစ်ကကည်ို့ပါ။ 

ဒါဆိိုရငသ်ကဆ်ိိုငရ်ာနိိုငင် ရ ို့ data ကိိုခပရပ်းတာကိိုရတ ွေ့ရ 

ပါလမ်ိို့မယ။် 

 

 

 

 

Country ကိိုအမ နခ်ပနခ်ြစပ်ပ ်း Select All ခပနလ်ိုပ်ပါ 

 

 

 

 

 

Edit ြလိုတက်ိိုန ပ်ိပပ ်း Edit 

Mode ခပနသ် ာ်းပါ 

 

 

 

ကျွနရ်တာ်တိို ို့ထည်ို့လိိုကတ် ို့ dropdown ဟာ သရူ ိရနတ ို့ chart မ ာပ အလိုပ်လိုပ်ရစြျင ်

ပါတယ။် တခြာ်းမဆိိုငတ် ို့ chart ရတ ရပေါ်သကရ်ရာကမ်ှုမရ ိရစြျင ် ပါဘ်ူး။ ဒါရကကာင်ို့ 

chart န ို့ dropdown ကိိုတ  ပပ ်း Group လိုပ်ရပ်းလိိုကရ်င ်အဆငရ်ခပပါတယ။် 

Keyboard က Ctrl/Cmd key 

ကိိုန ပ်ိထာ်းပပ ်း chart န ို့ dropdown 

ကိို selection တ  မ တပ်ါ။ 

 

 

 

 

 

Menu> Arrange > Group ကိိုရရ ်းပါ 

 

 

 

 

 

 

 

 

ဒ လိို Group ခဖစ်သ ာ်းပပ ဆိိုရင ် dropdown ဟာ group အတ င််းက chart ရပေါ်မ ာပ  

သကရ်ရာကပ်ါတယ။် ရဘ်းနာ်းမ ာ chart ရတ ရ ိလာရင ်သ ာ်းမရှုပ်ရတာို့ပါဘ်ူး။ 
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ရအာကမ် ာ ရနာကထ်ပ် chart တစ်ြိုထည်ို့ြျင ်

တာရကကာင်ို့ Report Document Size ရလ်း 

ကိိုနည််းနည််း ထပ်ြျ ွေ့ ဖိို ို့လိိုပါတယ။် Report ရ ို့ 

ရနရာလ တ ် တစ်ြိုမ ာ Right Click န ပ်ိပပ ်း 

Theme and layout ကိိုရရ ်းပါ။ 

 

 

 

 

ညာဘကက် Layout ကိိုထပ်သ ာ်းပါ 

 

 

 

 

 

 

 

 

 

 

Canvas Size မ ာ 16:9 Portrait 

ရရ ်းပါ။ 

 

 

 

 

 

ရအာကက်ရနရာလ တမ် ာ chart 

တစ်ြိုထပ်ထည်ို့ဖိို ို့ Add a chart 

ထ က Pie chart ကိိုရရ ်းပါ။ 
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ရအာကမ် ာရနရာြျပါ။ 

 

 

 

 

 

 

 

 

 

Looker Studio က ြန် ို့မ န််းရပ်းတ ို့ 

Dimension ရတ ကိိုခပနခ်ပငက်ကပါမယ။် 

ကျွနရ်တာ်တိို ို့ဒ တစ်ြါခပြျငတ်ာက နိိုငင်  

အလိိုက ် ကမ္ာို့လဦူ်းရရရာြိိုငန် ှုန််းခဖစ်ပါ 

တယ။် ညာဘက ်Data Panel ထ က Country 

ကိို ဘယဘ်က ် Dimension က Year 

ရပေါ်တည်ို့တည်ို့ဆ  ြျပါ။ 

 

 

 

ဒါဆိို Pie Chart ရလ်းဟာ နိိုငင် အလိိုက ် data လ လ ပပရလ်း ခပရပ်းမ ာခဖစ်ပါတယ။် ဒ  

data ကိို န စ်အလိိုကခ်ပနက်ကည်ို့လိို ို့ရရအာင ်Year Dropdown ထည်ို့ကကပါမယ။် 

 

Insert > Drop-down list ကိိုရရ ်းပါ။ 

 

 

 

 

 

 

 

 

ြိုနကလိိုပ  Pie chart ရ ို့ ညာဘကအ်ရပေါ် 

ရထာင်ို့မ ာ ရနရာြျပါ။ Looker Studio က 

ြန် ို့မ န််းတ ို့ Country filter မဟိုတဘ်  န စ်အ 

လိိုကခ်ပနက်ကည်ို့ြျငတ်ာမိို ို့လိို ို့ ညာဘက ်Data 

panel ထ က Year ကိို ဘယဘ်က ်Control 

ရအာကက် Country ရပေါ်တည်ို့တည်ို့ဆ  ြျ 

ပါ။ 
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အြို dropdown ကိိုလည််း ရဘ်းနာ်းက chart ကိိုသ ာ်းမရှုပ်ရရအာင ်Ctrol/Cmd 

ဖိထာ်းပပ ်း chart န ို့ dropdown ကိို select တ  မ တပ်ါ။ 

Menu > Arrange > Group ကိိုရရ ်းပါ။ 

 

 

 

 

 

 

 

 

ပပ ်းသရလာကက်ိို View ြလိုတန် ပ်ိပပ ်း 

ခပနက်ကည်ို့လိို ို့ရပါတယ။် 

 

 

 

Chart တစ်ြိုြျင််းစ ရ ို့ dropdown ရတ ကိို 

ရရ ်းကကည်ို့ပပ ်း စမ််းသပ်တ ို့အြါ dropdown 

တစ်ြိုရ ို့လိုပ်ငန််းဟာ မဆိိုင ် တ ို့ chart ကိို 

သကရ်ရာကမ်ှုရ ိမရ ိ စစ်ရဆ်း ပါ။ 

 

 

 

 

Data Blending ပပြုလပ်ုပြင််း 

ဒိုတယိထည်ို့လိိုကတ် ို့ Pie chart ဟာ Looker Studio ရ ို့ပ ိုရသ သရဘာအရ Metric 

အမျာ်းဆ ို်း Dimension ရတ ကိို ထပ်ိဆ ို်းကခပရပ်းတာမိို ို့လိို ို့ Metric နည််းတ ို့ Dimension 

ရတ ဟာ Other ထ  အလိိုလိိုရရာကသ် ာ်းပါတယ။် လဦူ်းရရကနိ််းဂဏန််းအရ တရိုတ၊် 

အနိဒယိ၊ အရမရိကန ် စတ ို့နိိုငင် ရတ ဟာ ထပ်ိဆ ို်းရရာကရ်နတာမ နရ်ပမယ်ို့ လဦူ်းရရနည််း 

တ ို့တခြာ်းနိိုငင် ရလ်းရတ ရ ို့ စိုစိုရပါင််းတနဖိ်ို်းဟာ နိိုငင် ကက ်းရတ ရ ို့လဦူ်းရရထကအ်ဆမတန ်

မျာ်းခပာ်းရနတာရကကာင်ို့ Pie chart မ ာကကည်ို့လိိုကရ်င ် Other တနဖိ်ို်းန ို့တင ် percentage 

ရတာ်ရတာ်မျာ်းမျာ်းရနရာယရူနတာ ကကည်ို့လိို ို့မရကာင််းပါဘ်ူး။ ဒါရကကာင်ို့ လဦူ်းရရကိို 

နိိုငင် အလိိုကမ်ဟိုတဘ်  ကမ္ာို့တိိုကက်က ်းမျာ်းန ို့ ခြ  ပပ ်းခပလိိုကတ်ာက ပိိုကကည်ို့ ရကာင််းပပ ်း 

သဘာဝလည််းပိိုကျပါတယ။် 

ဒါရပမယ်ို့ ကျွနရ်တာ်တိို ို့ ကနဦ်းတိုန််းက import လိုပ်ထာ်းတ ို့ data မ ာ နိိုငင် ပ ပါပပ ်းကမ္ာို့ 

တိိုကက်က ်းမျာ်း Continent မပါပါဘ်ူး။ အ ဒ ရတာို့ Continent data ကိို ရနာကထ်ပ် import 

လိုပ်ယပူပ ်း နဂိိုရ ိပပ ်းသာ်း နိိုငင်  data ရပေါ်မ ာ ခြ  ပပ ်းရဖာ်ခပနိိုငဖိ်ို ို့လိိုပါတယ။်ဒါမျိ ်းကိို Looker 

Studio မ ာ blend-in data လိို ို့ရြေါ်ပါတယ။် 
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Data ရနာကတ်စ်ြိုြျိတ ်

ဆကဖိ်ို ို့ Menu > 

Resource > Manage 

added data sources 

ကိိုသ ာ်းပါ။ 

 

 

 

 

 

Add a data source ကိိုန ပ်ိပါ 

 

 

 

 

ဒ တစ်ရြါကရ်တာို့ file upload 

ကိိုရရ ်းရမ ာခဖစ်ပါတယ။် 

 

 

 

 

 

File upload တစ်ြါမ မလိုပ်ဖူ်းရသ်းရင ်

Authorize ြလိုတန် ပ်ိရပ်းဖိို ို့လိိုပပ ်း လိုပ်ဖူ်းတ ို့ 

လရူတ ကရတာို့ ရပေါ်မ ာမဟိုတပ်ါဘ်ူး။ 

 

 

 

 

Google account ကိိုခပန ်confirm 

လိုပ်ရပ်းပါ။ 

 

 

 

 

 

 

Click to upload files ကိိုန ပ်ိပါ။ 
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သငြ်န််းစာ file ထ က 

Countries_Continents.csv file 

ကိိုရရ ်းပပ ်း Open လိုပ်ပါ။ 

 

 

 

 

 

File size အကက ်းအရသ်းရပေါ်မူတညပ်ပ ်း upload 

တငြ်ျိနအ်နည််းန ို့အမျာ်း ရစာင်ို့ရနိိုငပ်ါတယ။် 

Status မ ာ Uploaded လိို ို့ခပတ ို့အထရိစာင်ို့ပပ ်းမ  

Add ြလိုတက်ိိုန ပ်ိပါ။ 

Data န စ်ြို ရရာခပြျငတ် ို့ Pie chart ကိို 

select လိုပ်ပပ ်း ညာဘက ် Chart panel 

ထ က Blend data ကိိုရရ ်းပါ။ 

 

 

 

 

 

 

 

 

Join another table ကိိုန ပ်ိပါ။ 

 

 

 

 

Upload လိုပ်တာ်းထ ို့ 

Countries_Continents.csv file ကိိုရရ ်းပါ။ 

 

 

 

 

 

 

Data table န စ်ြိုကိို ရပါင််းပါရတာို့မယ။် Table န စ်ြိုကိိုရပါင််းရတာို့မယဆ်ိိုရငဘ် ိုတညူ တ ို့ 

Column တစ်ြိုစ ရ ိရပါမယ။် ကျွနရ်တာ်တိို ို့ရပါင််းမယ်ို့ table န စ်ြိုမ ာ Country Column 

တစ်ြိုစ ပါတာရကကာင်ို့ ဒ  Column န စ်ြိုကိို ြျိတလ်ိိုကလ်ိို ို့ရပါတယ။် ပထမ table က 

China ရ ို့ Year Population column န စ်ြိုဟာ ဒိုတယိ table က China ရ ို့ Continent 

န ို့ြျိတလ်ိိုကတ် ို့သရဘာရကကာင်ို့ ပ ိုမ ာခမငရ်သလိို blended table တစ်ြိုစိတက််ူးထ ပ ိုရဖာ် 

ကကည်ို့နိိုငပ်ါတယ။်  

Blended table မ ာ Population column က Metric အတ ကခ်ဖစ်ပပ ်း Year, Country, 

Continent က Dimension အတ ကခ်ဖစ်ပါတယ။် တကယရ်ိုပ်ထ ကခ်ပမယ်ို့ Dimension 
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က Continent ခဖစ်ပပ ်း Year က filter လိုပ်ဖိို ို့၊ Country က table န စ်ြို join ဖိို ို့ခဖစ်ပါ 

တယ။် 

 

 

Blend လိုပ်မယ်ို့ data မ ာ ပထမ 

table က Country န ို့ Year column 

န စ်ြိုဆ  ယပူါမယ။် 

Table 1 dimension မ ာ country 

ရ ိပပ ်းသာ်းမိို ို့လိို ို့ ညာဘကက် Year 

ကိိုဆ  ယပူပ ်း Country ရအာကက် 

Add dimension မ ာရနရာြျပါ 

 

 

Table 2 က Continent ကိို 

Country ရအာကက် Add 

dimension ရပေါ်ဆ  ြျပါ။ 

 

 

 

 

 

 

Configure join ကိိုန ပ်ိပါ။  

 

 

 

Join configuration မ ာ Left outer ကိိုရရ ်းပါ။ Table 1 ကိိုအရသထာ်းပပ ်း Table 2 ထ က 

တတူ ို့ column ရ ို့ row ရတ ကိိုဆ  ယတူ ို့သရဘာပါ။ အရခြြ မိို ို့လိို ို့ တခြာ်း join နည််းရတ  
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အကျယမ်ရခပာ 

ရတာို့ပါဘ်ူး။ ရအာကက် 

Join condition မ ာ Table 

1 က Country န ို့ Table 2 

က Country join 

လိိုကတ်ာရတ ွေ့ နိိုငပ်ါတယ။် 

Save န ပ်ိပါ။ 

Blended table မ ာ 

Dimension ၃ ြိုန ို့ Metric 

၁ ြိုရပါမယ။် ရနာကတ်စ်ရြါက ်Save 

န ပ်ိပါ။ 

 

 

 

 

 

 

Pie chart ကိို select ခပနလ်ိုပ်ပါ။ ဒ တစ ်

ရြါကမ် ာ Continent ကိိုပ ခပရတာို့မ ာမိို ို့လိို ို့ 

ညာဘက ်Blended data ထ က Continent ကိို 

ဘယဘ်က ်Dimension ရအာကက် Country 

ရပေါ်တည်ို့တည်ို့ဆ  ြျပါ။ 

 

 

 

 

 

 

ပ ိုမ ာခမငရ်တ ို့အတိိုင််း Continent 

အလိိုက ် လဦူ်းရရ ရာြိိုငန် ှုန််းကိိုရဖာ်ခပ 

ရပ်းမ ာခဖစ်ပါ တယ။် 

 

 

 

Report Formatting 
အရရာငထ်ည်ို့တာ၊ ရြါင််းစဉထည်ို့တာ စတ ို့တနဆ်ာဆငတ် ို့အပိိုင််းရတ ကိို ဒ အဆင်ို့ 

ရရာကမ်  အာရ ိုစိိုကတ်ာပိိုရကာင််းပါတယ။် Report စလိုပ်ကတည််းက Formatting ကိို 

အာ်းကိုနထ်ည်ို့လိိုကမ်ရိင ်အလိုပ်မတ ငဘ် ရ ိတတပ်ါတယ။် Formatting အြျိနက်ိုနြ် ခပင ်

ဆငပ်ပ ်းမ  အသ ို်းမဝငလ်ိို ို့ဖျကလ်ိိုကရ်ရင ်န ရမျာဖိို ို့ရကာင််းပါတယ။် 
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Report ကိိုကကည်ို့လိိုကတ်ာန ို့ ဘာကိိုခပြျငမ် န််းသသိာရအာင ် ရြါင််းစဉရလ်းတပ်ပါမယ။် 

Menu က Text ကိိုရရ ်းပါ။ 

 

 

 

Report အရပေါ်ဆ ို်းမ ာ ရနရာြျပပ ်း “World Population Dashboard” လိို ို့ရရ်းပါ။ 

 

 

Font Color - အခဖြူရရာင၊် Font-size 40px ၊ Center 

Alignment ၊ Background Colour မ ာအရရာငရ်င်ို့တာ 

တစ်ြိုြိုရပ်းပါ။ 

 

 

 

 

 

ဒ ရလာကဆ်ိိုနည််းနည််းကကည်ို့လိို ို့ရကာင််းလာပါပပ ။ ဒ စာမျကန် ာက တကမ္ာလ ို်းက data 

ရတ ကိို ခြ  င ိုခပသတ ို့ စာမျကန် ာခဖစ်ပပ ်း ဝငဝ်ငြ်ျင််းခမငရ်မယ်ို့ရနရာခဖစ်ပါတယ။်  

နိိုငင် တစ်ြိုြျင််းအလိိုက ်data ရတ ခပဖိို ို့ ရနာက ်စာမျကန် ာတစ်ြိုဖနတ် ်းကကပါမယ။် 

Menu > Add Page ကိိုန ပ်ိပါ။ 

 

 

 

Page Manager မ ာ page ရနာကတ်စ်ြိုတိို်းလာတာ 

ခမငရ်မ ာခဖစ်ပါတယ။် 
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မူလစာမျကန် ာကိိုခပနသ် ာ်းြျငရ်င ်

ဘယဘ်ကအ်စ နက် (1) ကိိုန ပ်ိနိိုငပ်ါတယ။် 

 

 

 

ြိုနက Page Manager ကိို ရနာကမ်  

ခပနသ် ာ်းြျငရ်င ် Menu > Page > 

Manage Pages ကိိုရရ ်းပါ။ 

Page Manager ခပနရ်ပေါ်လာပါလမ်ိို့မယ။်  

 

 

ပထမစာမျကန် ာကိို Summary Page ၊ 

ဒိုတယိစာမျကန် ာကိို Country Page 

လိို ို့နာမညရ်ခပာင််းပါ။ 

 

 

 

ပထမစာမျကန် ာရြါင််းစဉ 

ကိို “World Population 

Dashboard” လိို ို့ရခပာင််း 

ပါ။ 

 

ဒိုတယိစာမျကန် ာရြါင််းစဉကိို 

“Country Dashboard” 

လိို ို့ရခပာင််းပါ။ 

ဒိုတယိစာမျကန် ာမ ာ chart ရတ  

စထည်ို့ပါရတာို့မယ။် Add a chart > Time 

Series Chart ကိိုရရ ်းပါ။ Document Canvas 

အရပေါ် ပိိုင််းမ ာ ရနရာြျပါ။ 

 

 

 

 

ရနာကထ်ပ် Time Series Chart 

တစ်ြိုထပ်ယပူါ။ ပထမတစ်ြိုရ ို့ ရအာကမ် ာ 

ရနရာြျပါ။ 

န စ်ြိုရနရာြျပပ ်းပပ ဆိိုရငပ် ိုမ ာခပထာ်း 

တ ို့အတိိုင််းရတ ွေ့ရမ ာ ခဖစ်ပါတယ။် 

ပထမ chart က ြိုန စ်အလိိုကတ်ိို်း တကလ်ာ 

တ ို့ကမ္ာို့လဦူ်းရရခဖစ်ပါတယ။် ဒ တစ်ကကမ်ိမ ာ 

Looker Studio ြန် ို့မ န််းတာက ကျွနရ်တာ်တိို ို့ ခပြျငတ် ို့ပ ိုန ို့ကိိုကည် တာမိို ို့လိို ို့ ဒ တိိုင််းထာ်း 

လိိုကပ်ါမယ။် 

ဒိုတယိပ ိုရနရာြျလိိုကတ် ို့အြါ လိိုြျငတ် ို့ပ ိုစ မဟိုတရ်သ်းပါဘ်ူး။ ြိုန စ်အလိိုက ် Mobile 

network အသ ို်းခပ သရူာြိိုငန် ှုန််းကိိုခပြျငတ်ာပါ။ ဒိုတယိ chart ကိို select လိုပ်ပပ ်း data 

source မ ာ Blended data မဟိုတရ်တာို့ဘ  Population data ကိိုခပနရ်ရ ်းရပ်းပါ။ 
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ညာဘက ် Data panel က Mobile 

subscription % ကိို ဘယဘ်က ် Metric 

ရအာကက် Country ရပေါ်တည်ို့တည်ို့ဆ  ြျ 

ပါ။ သတခိပ ဖိို ို့က mobile subscription % 

တနဖိ်ို်းကိိုယဖိူို ို့ပါ။ mobile subscriptions 

column မဟိုတပ်ါဘ်ူး။ 

ဒါဆိို Year အလိိုက ် Mobile subscription 

percentage အတကအ်ကျကိိုခမငရ်မ ာခဖစ ်

ပါတယ။် 

 

 

Scorecard ထည့််သငွ််းပြင််း 

ရနာကတ်စ်ြိုကရတာို့ ကနိ််းဂဏန််းရတ ကိို Scorecard သ ို်းပပ ်းခမငသ်ာထငသ်ာရအာင ်

ခပပါမယ။် 

Menu > Insert > Scorecard 

ကိိုရရ ်းပါ။ 

 

 

 

 

 

 

 

 

ပထမ chart ရ ို့ညာဘကအ်ရပေါ်နာ်းမ ာ 

ရနရာြျပါ။ 
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လဦူ်းရရကနိ််းဂဏန််းကိိုခပြျငတ်ာမိို ို့လိို ို့ 

Data ရအာကက် Population ကိို Metric 

ရအာကက် Record Count ရပေါ်တည်ို့ 

တည်ို့ဆ  ြျပါ။ 

 

 

 

 

 

 

 

ဂဏန််းရတာို့ရခပာင််းသ ာ်းရပမယ်ို့ ကမ္ာို့လဦူ်းရရထက ်အဆမတနမ်ျာ်းရနတာသတထိာ်းမိ 

မ ာပါ။ ဘာလိို ို့လ ဆိိုရတာို့ table မ ာပါတ ို့ ြိုန စ်အာ်းလ ို်းကိို ရပါင််းပပ ်းခပတာမိို ို့လိို ို့ပါ။ ကျွန ်

ရတာ်တိို ို့ data table ကရနာကဆ် ို်းြိုန စ်အတ ကလ်ဦူ်းရရကိို 

ရရ ်းခပမ  လကရ် ိတနဖိ်ို်းန ို့အန ်း စပ်ဆ ို်းခဖစ်မ ာပါ။  

ဒါရကကာင်ို့ Scorecard filter ရအာကက် Add a filter 

ကိိုန ပ်ိပါ။  

 

 

 

 

 

 

Select a field ကိိုန ပ်ိပါ။ 

 

 

 

 

Year ကိိုရရ ်းပါ။ 

 

 

 

 

Equal to (=) န ို့ 2014 

ထည်ို့ရပ်းပါ။ data 

table မ ာ 2014 က 

ရနာကဆ် ို်းမိို ို့လိို ို့ခဖစ်ပါ 

တယ။်  

ဒါဆိိုဂဏန််းမ နသ် ာ်းပါပပ ။ ရနာကထ်ပ် Scorecard တစ်ြိုယဖိူို ို့ Menu > Insert > 

Scorecard ကိိုရရ ်းပပ ်း ပထမ Scorecard ရအာကမ် ာ ရနရာြျပါ။ Mobile Subscription 

% ကိိုခပြျငပ်ါတယ။် 
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ညာဘကက် Mobile 

Subscription % ကိို Metric 

ရပေါ်ကိိုဆ  ြျပါ။ 

ဒ ရာြိိုငန် ှုန််းဟာလည််း 

အမ တတ်မ ို့ကကည်ို့လိိုကရ်င ်

မ နသ်လိိုလိိုရ ိရပမယ်ို့ 

ြိုန စ်အာ်းလ ို်းရ ို့ mobile 

subscription % တနဖိ်ို်းကိို Average ခပရပ်းတာခဖစ်ပါတယ။် ဘာလိို ို့လ ဆိိုရတာို့ report 

လိုပ်ကာစမ ာ percent ရ ို့ default aggregate ကိို average ရပ်းြ ို့တာမိို ို့လိို ို့ပါ။ သူ ို့ကိို 

လည််း ရနာကဆ် ို်းြိုန စ်ရ ို့ တနဖိ်ို်းကိိုခပရအာင ်filter လိုပ်ရပ်းရပါမယ။် 

Add a filter ကိို န ပ်ိပါ။ Year filter 

တစ်ြိုရ ိပပ ်းသာ်းခဖစ်ရနပါလမ်ိို့မယ။် 

အ ဒ  Year filter ကိိုပ ရရ ်းရပ်းပါ။ 

ဒါဆိို Mobile Subscription % 

တနဖိ်ို်းဟာ ရနာကဆ် ို်းန စခ်ဖစ်တာ 

ရကကာင်ို့ ဂဏန််းတနဖိ်ို်းခမင်ို့လာတာ 

သတထိာ်းမိပါလမ်ိို့မယ။် 

 

Geo Chart ထည့််သငွ််းပြင််း 

ဒ စာမျကန် ာဟာ နိိုငင် အလိိုကစ်ာမျကန် ာခဖစ်တာရကကာင်ို့ သကဆ်ိိုငရ်ာနိိုငင် ကိို ရခမပ ို 

chart ကရလ်းန ို့ခပြျငပ်ါရသ်းတယ။် 

ဒါရကကာင်ို့ Add a chart ထ က Geo chart 

ကိိုရရ ်းပပ ်း ပ ိုမ ာခပထာ်းသလိို ရနရာြျပါ။ 

 

 

 

 

 

 

Geo chart ဟာ error မရ ိဘ  

ရပေါ်လာပါ လမ်ိို့မယ။် ကျွန ်

ရတာ်တိို ို့ report စဖနတ် ်း 

တိုန််းက data ြျိတတ် ို့အြါ 

Country column ကိို Text 

ကရန Geo Country ရခပာင််း 

ရပ်းြ ို့လိို ို့ရခမပ ိုရပေါ်မ ာနိိုငင် အ 

လိိုက ် error မပါဘ ခမငရ်တာ 

ခဖစ်ပါတယ။် 
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ရခမပ ိုတနဖိ်ို်းဟာလည််း ြိုန စ် 

အာ်းလ ို်းတနဖိ်ို်းကိိုရပါင််းပပ ်း 

ခပရနတ ို့အတ ကတ်စ်န စ် 

တည််းတနဖိ်ို်းခဖစ်ရအာင ်

Year filter ထပ်ထည်ို့ရပ်းပါ 

 

 

 

ရခမပ ိုမ ာ လဦူ်းရရတနဖိ်ို်းအလိိုက ်

အနိုအရင်ို့ခပြျငတ်ာမိို ို့လိို ို့ 

Population ကိို ရခမပ ိုရ ို့ Metric 

ထ က Mobile subscription % 

ရပေါ်တည်ို့တည်ို့ဆ  ြျပါ။ 

ဒါဆိိုရနာကဆ် ို်းြိုန စ်ရ ို့လဦူ်းရရအ 

နည််းအမျာ်းကိို ရခမပ ိုမ ာခမငရ်ပါပပ ။ 

 

 

 

 

ပ ိုရအာကက် အရရာငအ်နိုအရင်ို့ legend ကက ်းကမျကစ်ိရှုပ် 

တာရကကာင်ို့ ရခမပ ို chart ရ ို့ style ထ မ ာ Show legend 

ကိိုအမ နခ်ြစ်ခဖ တရ်ပ်းပါ။ 

 

 

 

ဒါဆိို chart ရတ စ ိုပါပပ ။ 

Page Level filter ထည့််ပြင််း 

နိိုငင် အလိိုကခ်ပမယ်ို့စာမျကန် ာမိို ို့လိို ို့ Country ကိို filter လိုပ်လိို ို့ ရရအာင ်dropdown 

ထည်ို့ရပ်းပါမယ။်  

Dropdown ရနရာြျလိို ို့ရရအာငရ်ြါင််း 

စဉကိို ပ ိုမ ာခပထာ်းတ ို့အတိိုင််း size ြျ  ွေ့ရပ်း 

ပါ။ 

 

ဒ တစ်ြါရတာို့ Insert ထ ကမသ ာ်းဘ  Add a 

control ထ က Drop-down list ကိိုရရ ်းပါ။ 
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ပ ိုမ ာခပထာ်းတ ို့အတိိုင််းရနရာြျပါ။ 

 

 

Looker Studio က Country အတ ကသ် ို်းမယ်ို့ Dropdown filter လိို ို့အတအိကျြန် ို့မ န််း 

ရပ်းလိိုကတ်ာရကကာင်ို့ ဘာမ ထပ်ခပငစ်ရာမလိိုရတာို့ပါဘ်ူး။ Country မဟိုတရ်ငရ်တာို့ 

country ခဖစ်ရအာငခ်ပငရ်ပ်းဖိို ို့လိိုပါတယ။် 

အလိုပ်လိုပ်မလိုပ်စမ််းကကည်ို့ရရအာင ်View 

ြလိုတက်ိိုန ပ်ိပါ။ 

 

 

Country dropdown 

ကိိုန ပ်ိပပ ်း Search မ ာ 

Myanmar လိို ို့ရိိုက ်

ထည်ို့ပပ ်း Onlyကိိုန ပ်ိပါ။ 

 

ခမနမ်ာနိိုငင် ရ ို့ လဦူ်းရရဟာ တစ်န စ်ကိိုငါ်းသနိ််းရလာကတ်ိို်းရနပပ ်း Mobile % က CDMA 

ဖိုန််းရတ  ငါ်းသနိ််းန ို့ဝယလ်ိို ို့ရတ ို့ 2011 ရနာကပိ်ိုင််းအနည််းငယတ်ိို်းတကလ်ာရာကခပည ်

တ င််းခပညပ် mobile operator ရတ ဝငလ်ာတ ို့ 2013ရနာကပိ်ိုင််းရိုတတ်ရကရ်ထာင ်

တကသ် ာ်းတာ ရတ ွေ့ရမ ာပါ။ 

 

ရခမပ ိုမ ာတစ်နိိုငင် တည််းရရ ်းကကည်ို့လိို ို့ရ 

သလိို ထပ်ထည်ို့ြျငတ် ို့နိိုငင် ကိိုအမ နခ်ြစ် 

ပပ ်း ရပါင််းကကည်ို့လိို ို့ရပါတယ။်ပ ိုကရတာို့ 

ခမနမ်ာန ို့ထိိုင််းန စ်နိိုငင် ကိိုရပါင််းခပထာ်း 

တာပါ။ 

 

 

 

 

 

တကယ်ို့လကရ်တ ွေ့ မ ာ န စန်ိိုငင် ၊ သ ို်းနိိုငင်  ရပါင််းကကည်ို့တ ို့လမူရ ိသရလာကန်ည််းပပ ်း 

dropdown မ ာ multi-select ရပ်းထာ်းတာက အသ ို်းခပ သကူိိုရှုပ်ရထ ်းမှုခဖစ်ရစလိို ို့ 

single select ရခပာင််းကကပါမယ။် 
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Edit ြလိုတက်ိိုခပနန် ပ်ိပပ ်း Dropdown 

style ထ မ ာ single selectကိိုအမ နခ်ြစ ်

ရပ်းပါ။ 

 

 

 

 

View Modeန ို့ခပနက်ကည်ို့မယဆ်ိိုရင ်

တစ်နိိုငင် တည််းရရ ်းလိို ို့ရပါပပ ။ နိိုငင်  

နာမညရ်ဘ်းမ ာလဦူ်းရရကိိုကနိ််းဂ 

ဏန််းတစ်ြိုန ို့ခပရပ်းရနတာသတ ိ

ထာ်းမိမ ာပါ။ 

 

ဒါကလည််း မျကစိ်ရှုပ်စရာမိို ို့လိို ို့ Edit ခပနသ် ာ်းပပ ်း 

dropdown ရ ို့ Setup ရအာကက် show values 

ကိိုအမ နခ်ြစ်ခဖ တရ်ပ်းပါ။ 

 

 

 

 

Dropdownကိိုရြါင််းစဉန ို့တသူ ာ်းရအာင ် formatting ခပငပ်ါမယ။် Style ထ မ ာ font 

colour အခဖြူရရာင၊် font-size 18px ၊ Background colour ကိိုရြါင််းစဉကအရရာင ်

အတိိုင််းထာ်းပါ။ 
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ဒိုတယိ chart ကိို ပထမ 

chart န ို့အရရာငက်  သ ာ်း 

ရအာင ်Style ထ မ ာမတတူ ို့ 

အရရာငတ်စ်ြိုရပ်းပါ။ 

Formatting က 

ဒ ရလာကဆ်ိိုရပါပပ ။ 

 

 

 

Sharing the Report 
ရနာကတ်စ်ဆင်ို့ကရတာို့ ကိိုယလ်ိုပ်ထာ်းတ ို့ Report ကိို ဘယသ်ူ ို့ကိို ဘယလ်ိို share 

မလ ဆိိုတာပါ။ အငတ်ာနကမ် ာ ကိိုယ်ို့ report ရ ို့ link ကိို ရတ ို့လတူိိုင််းရပ်းကကည်ို့မလာ်း၊ 

ကကည်ို့ရစြျငတ် ို့လပူ ရပ်းကကည်ို့မလာ်း သတမ် တရ်ပ်းလိို ို့ရပါတယ။် သ ်းသန် ို့လတူြျိ ွေ့ကိိုပ  

ခပဖိို ို့ဆိိုရင ်သတူိို ို့ရ ို့ Gmail လပ်ိစာရတ န ို့ share လိို ို့ရပါတယ။် 

ဒ ရနရာမ ာ သတထိာ်းရမ ာက email လပ်ိစာန ို့ပ  share မယဆ်ိိုရင ် Gmail လပ်ိစာရယ၊် 

Gmail သ ို်းလိို ို့ရတ ို့ တခြာ်း email လပ်ိစာရတ ရယပ်  share လိို ို့ရပါတယ။် Looker 

Studio က Google ရအာကက်မိို ို့လိို ို့ Gmail လပ်ိစာန ို့ share ရငက်ကည်ို့လိို ို့ရမ ာခဖစ်ပပ ်း 

Google Workspace ဝနရ်ဆာငမ်ှုကရနဝယသ် ို်းတာမဟိုတတ် ို့ လိုပ်ငန််းသ ို်း email 

account ရတ ကိို share လိို ို့မရနိိုငပ်ါဘ်ူး။ 

Gmail ပျို ့်၍ Share ပြင််း 

Gmail န ို့ share ဖိို ို့ Share ြလိုတက်ိိုန ပ်ိပါ။ မမိိ share ြျငတ် ို့လရူ ို့ gmailလပ်ိစာထည်ို့ ပါ။ 

ကကည်ို့ပ ကကည်ို့ရစြျငရ်င ်Viewer ရပ်းပါ။ ဝငခ်ပငတ်ာပါလိုပ်ရစြျငရ်င ်Editor ရပ်းပါ။ 

 

Report Link ထတုပ်ြင််း 

Report ရ ို့ link ထိုတဖိ်ို ို့ Share ရ ို့ရဘ်းနာ်းက 

ခမာ်းရြါင််းရလ်းကိိုန ပ်ိပါ။ Get Report Link 

ကိိုရရ ်းပါ။ 

 

 

 

Copy Link ြလိုတက်ိိုန ပ်ိပပ ်း Email 

ရရ်းတ ို့အြါ Link ကိို paste လိုပ်ပပ ်း 

ပိို ို့နိိုငပ်ါတယ။် 
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Share ထ ်းသကူျိပုပန်ပ ြုတပ်ြင််း 

Share ပပ ်းသာ်းလရူ ို့ Gmail ကိိုခပနခ်ဖ တြ်ျငတ်ယဆ်ိိုရင ် Share ြလိုတက်ိိုန ပ်ိ၊ 

ခဖ တြ်ျငတ် ို့လရူ ို့ Gmail ရဘ်းက ြလိုတက်ိိုန ပ်ိပပ ်း Remove Access ကိိုရရ ်းပါ။ 

 

Share Settings 
Report ကကည်ို့တ ို့သကူိို 

Download ၊ Copy ၊ Print 

လိုပ်လိို ို့မရရအာငပိ်တထ်ာ်းြျင ်

တယဆ်ိိုရင ်Share ြလိုတက်ိိုန ပ်ိ၊ 

Setting ကိိုန ပ်ိပါ။ 

 

 

 

Editor ရပ်းထာ်းတ ို့လ ူ

သူ ို့ဘာသာသလူသူစ်ထပ်ထည်ို့တာ မျိ ်း 

မလိုပ်ရစြျငရ်င ်“Prevent editors 

from changing access and adding 

new people” အမ နခ်ြစ်ပါ။ 

Download, Print, Copy ပိတြ်ျငရ်င ်ဒိုတယိအရကကာင််းကိိုအမ နခ်ြစ်ပါ။ 

Link ရသတူျိငု််းကကည့််နျိငုအ်အ င ် ွင့််အပ်းပြင််း 

 

Share ကိိုန ပ်ိ၊ Link Setting 

မ ာ Public ရရ ်းပါ။ 

ညာဘကအ်ခြမ််းမ ာ Viewer 

ဆကရ်ရ ်းပါ။ 

 

 

 

 

ယြိုသငြ်န််းစာအတ ကခ်ပ လိုပ်ထာ်းတ ို့ report ကိို Anyone 

with the link can view န ို့ share ထာ်းပါတယ။် 

နမူနာအရနန ို့ကကည်ို့ရနန် ပ်ိပါ။ သိို ို့မဟိုတ ်QR ကိို scan 

ပပ ်းကကည်ို့နိိုငပ်ါတယ။် 

https://lookerstudio.google.com/reporting/f924b3d8-6110-472b-bd66-89b9656817f5
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Looker Studio အတကွ ်Data ပပငဆ်ငပ်ြင််း 

Microsoft Excel န ို့ Google Sheet ထ မ ာ chart ရတ လိုပ်ြ ို့ဖူ်းတ ို့သဆူိိုရင ်Looker Studio 

သ ို်းြါစမ ာ အြကအ်ြ ရ ိတတပ်ါတယ။် အ ဒ မ ာ chart ရတ graphရတ လိုပ်ရလ ယ ်

သရလာက ်Looker Studio မ ာ data ကိိုရသရသြျာြျာမခပငရ်ပ်းမရိင ်chartထ ကဖိ်ို ို့ြက ်

တတပ်ါတယ။် 

Excel, Google Sheet မ ာ aggregate data ၊ တနည််းအာ်းခဖငို့ ်ရပါင််းထာ်းတ ို့ data ကရန 

chart ထိုတန်ိိုငရ်ပမယို့ ်Looker Studio မ ာမရပါဘ်ူး။ Raw data လိို ို့ရြေါ်တ ို့ dataကကမ််းန ို့ပ  

အလိုပ်လိုပ်ပါတယ။် data entry တစ်ြိုကိို row တစ်ြိုလ ို်းရပ်းမ ရပါတယ။်ရပါင််းထာ်းတ ို့ 

data ရတ ၊ merge လိုပ်ထာ်းတ ို့ cell ရတ ပါရင ်Looker Studio မ ာအလိုပ်မလိုပ်ပါဘ်ူး။ 

ရအာကက်ဇယာ်းကကျွနရ်တာ်တိို ို့ Excel မ ာလိုပ်ရနကျပ ိုစ မျိ ်းပါ။ column ရလ်းြိုရ ိမယ၊် 

ရကစ်  ၊ မနကစ်ာ၊ ရန ို့လယစ်ာ၊ ညစာ ပါမယ။် ကျွနရ်တာ်တိို ို့ တစ်ရန ို့တစ်ရန ို့ဘာစာ်းလ  

မ တတ် ို့ဇယာ်းရပါ ို့ရလ။အရစာပိိုင််းမ ာဝကသ်ာ်းကကကသ်ာ်းစာ်းနိိုငရ်ပမယို့လ်ကိုနြ်ါန ်း

ရတာို့ ငါ်းပိန ို့လကဖ်ကသ်ိုတန် ို့ပ စာ်းရတယရ်ပါ ို့။ 

 

Looker Studio အတ က ်table လိုပ်ရတာို့မယဆ်ိို ပ ိုရသမ တရ်မ ာက - 

• New record ဟာ row န ို့ဝငရ်ပါမယ ်

• Parameter ရတ က column မ ာရ ိရပါမယ ်

Data ထညို့လ်ကစ် ၂၂ ရကရ်န ို့အထပိပ ်းပပ ၊ ရနာကရ်န ို့အတ က ် data ထညို့မ်ယဆ်ိို 

23/1/2024 အတ က ်ရနာကထ်ပ် row တစ်ြိုဝငလ်ာမ ာခဖစ်ပါတယ။် အ လိိုပ ရနာကထ်ပ် 

data entry လိုပ်တိိုင််း ရအာကမ် ာ row တစ်ြိုဝငလ်ာရပါမယ။် data entry လိုပ်တိိုင််း 

row တစ်ြိုပ တိို်းလာရပါမယ။် column တိို်းလာလိို ို့မရပါဘ်ူး။ table က ဒ  table ပ ၊ 

ဒါရပမယို့ ်data studio မ ာ အလိုပ်မလိုပ်တ ို့ table က ရအာကက်ပ ိုစ မျိ ်းပါ။ 

 

Date ရတ က column ရရာကသ် ာ်းပပ ်း parameter ရတ က row မ ာရရာကရ်နပါတယ။် 

ရနာကတ်စ်ရကအ်တ က ် data entry လိုပ်ရတာို့မယဆ်ိို new column 

ယပူပ ်းထညို့ရ်မယို့သ်ရဘာပါ။ ဒါမျိ ်းဆိိုရင ် Looker Studio မ ာအလိုပ်မလိုပ်ပါဘ်ူး။ 

Looker Studio မ ာသ ို်းရရအာင ် data ခပငရ်ပ်းရတာဟာ relational database 

တစ်ြိုတညရ်ဆာကပ် ိုန ို့ဆငတ်ပူါတယ။် ဒ ပ ိုစ ကိိုရင််းန  ်းသ ာ်းရင ် relational database 

ရတ ခဖစ်တ ို့ MySQL, PostgreSQL တိို ို့ကိိုရလို့လာလိို ို့လ ယက်သူ ာ်းမ ာခဖစ်ပါတယ။် 
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သငြ်န််းစာမ ာ အသ ို်းခပ ြ ို့တ ို့ Google sheet ကိိုနမူနာကကညို့ရ်ရအာင။်

 

Data ရ ို့ Parameter ရတ ခဖစ်တ ို့ Country, Country code, Year, Population, 

Internet Users စတာရတ ကိို column မ ာထာ်းပါတယ။် န စ်အလိိုက ်data ရတ က row 

အရနန ို့လာသမ်ိ်းပါတယ။် 

2005 အတ က ် row အာ်းလ ို်းပပ ်းရင ် ဒ နိိုငင် အစဉလိိုကအ်တိိုင််းပ  2006 အတ က ် row 

ရတ ခပနစ်ပါတယ။် နိိုငင် စိုစိုရပါင််း 215 နိိုငင် ရ ိရင ် ရနာကတ်စ်န စ်အတ က ် 215 row 

ခပနလ်ာရပါမယ။် row မ ာ 215 row ကိို အရသထာ်းပပ ်း ြိုန စ်အလိိုက ် data ရတ ကိို 

column ရတ မ ာထပ်တိို်းခဖညို့တ်ာမျိ ်းဆိိုရင ်Looker Studio မ ာအလိုပ်မလိုပ်ပါဘ်ူး။  

 

သငြ်န််းစာအတ ကသ် ို်းတ ို့ Google Sheet ကိို 

ဒ မ ာနမူနာကကညို့န်ိိုငပ်ါတယ။် 

ဒါမ မဟိုတ ်QR scan ပပ ်းကကညို့န်ိိုငပ်ါတယ။် 

Looker Studio အရခြြ ကရတာို့ ဒ ရလာကပ် ခဖစ်ပါတယ။် 

ဒ န စ်ရတ မ ာ Data Science ကအရမ််းရြတစ်ာ်းလာပပ ်း AI ရတ ကိိုလည််း data 

ရပ်းဖိို ို့လိိုတာမိို ို့လိို ို့ AI နည််းပညာထ န််း ကာ်းလာရလရလ data သမာ်းရတ လည််း 

ပိိုလိိုလာရလခဖစ်ပါတယ။် ရနာကပိ်ိုင််းဆိိုရင ် အရခြြ က နခ်ပြူတာတတရ်ခမာကမ်ှုမ ာ 

Windows Operating System, Microsoft Office, Google Services 

ရတ န ို့တငမ်လ ိုရလာကရ်တာို့ဘ  Data Science ပါဝငလ်ာ ရတာို့မ ာမိို ို့လိို ို့ data handling 

န ို့ data visualization ဆိိုတာ လတူိိုင််းသထိာ်းသငို့တ် ို့ အရကကာင််းအရာခဖစ်လာမ ာ 

ခဖစ်ပါတယ။် data science ကိိုစိတဝ်ငစ်ာ်းတယဆ်ိိုရင ်relational database ရတ ထ က 

MySQL database ၊ Programming language ထ က Python တိို ို့ကိို 

ဆကလ်ကရ်လို့လာထာ်းသငို့ပ်ါတယ။် 

အာ်းလ ို်းအဆငရ်ခပကကပါရစ 

https://docs.google.com/spreadsheets/d/1GeFNENfpZVcN8gbjYHyzzZD72LOuyx7kt-SRzh4ofKs/edit?usp=sharing
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